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Izvleček 

Diplomska naloga govori o oblikovanju koledarja. Razdeljena je na teoretični in praktični 

del. Teoretični del opiše zgodovino in vrste koledarjev, praktični del pa prikaže postopek 

oblikovanja in izdelave 12-listnega stenskega koledarja od ideje do končnega izdelka. Cilj 

naloge je raziskati in predstaviti ključne oblikovalske elemente, ki vplivajo na vizualno in 

uporabniško vrednost koledarja. Uporabljene metode vključujejo analizo obstoječih 

oblikovalskih praks, pregled sodobnih trendov in tehnik ter praktično izvedbo lastnega 

koledarja. Opisana je tudi priprava na tisk, vključno z izbiro materialov, ki zagotavljajo 

kakovost končnega izdelka. Rezultati naloge potrjujejo, da je celovit pristop k oblikovanju 

in natančna priprava na tisk ključna za dosego visokokakovostnega izdelka, ki ustreza 

potrebam uporabnikov.  

Ključne besede 

koledar, grafično oblikovanje, tiskovina, fotografija, ilustracija, tipografija, priprava na tisk 

  



  

 

  

 

 

Abstract  

The diploma is about creating the design of a calendar. It is divided into theoretical and 

practical parts. The theoretical part describes the history and types of calendars. The practical 

part demonstrates the process of designing and producing a 12-page wall calendar, from the 

initial concept to the final product. The goal of the assignment is to explore and present the 

key design elements that impact the visual and user value of a calendar. The methods used 

include an analysis of existing design practices, an overview of contemporary trends and 

techniques and the practical creation of a calendar. The preparation for printing is also 

described, including the selection of materials that ensure the quality of the final product. 

The results of the task confirm that a comprehensive approach to design and accurate 

preparation for printing are crucial for achieving a high-quality product that meets the needs 

of users. 

Key words 

calendar, graphic design, printed material, photography, illustration, typography, print 

preparation
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1 Uvod 

Koledarji so nepogrešljivo orodje, ki nam pomaga organizirati naš vsakdan. V sodobnem 

času, ko se osebni in poklicni načrti vse bolj prepletajo, nam pomaga, da si zapomnimo 

pomembne datume, kot so rojstni dnevi, obletnice, termini pri zdravniku in sestanki v službi, 

opomni nas na praznike in dela proste dni, pomaga nam pri organizaciji dopustov in potovanj. 

Kljub številnim digitalnim rešitvam, pa klasičen koledar še vedno ostaja pomemben del naših 

življenj, saj ponuja enostaven in pregleden način za spremljanje datumov. Skoraj vsak od nas 

ima v gospodinjstvu vsaj en stenski koledar, zato sem se odločila, da bom svojo diplomsko 

nalogo posvetila ravno tej temi.  

Ta diplomska naloga temelji na podlagi realnega projekta, katerega cilj je oblikovanje 

koledarja za leto 2024, ki bo ustrezal potrebam konkretnih uporabnikov. Naloga bo 

razdeljena na teoretični in praktični del.  

Teoretični del naloge bo zajemal pregled zgodovine koledarjev, analizo osnovnih principov 

grafičnega oblikovanja koledarjev ter pregled obstoječih koledarjev za analizo njihovih 

funkcionalnosti in oblikovalskih trendov. 

Praktični del naloge bo zajemal prikaz in podroben opis postopka izdelave 12-listnega 

stenskega koledarja, od začetne ideje do končnega izdelka. Oblikovanje koledarja bo 

izvedeno s pomočjo programov Adobe Photoshop in Adobe Illustrator, pri čemer bom 

prikazala vse faze ustvarjanja, vključno z oblikovanjem vizualnih elementov in pripravo za 

tisk. 
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2 Namen in cilji diplomskega dela 

Namen tega diplomskega dela je raziskati in razviti celovit pristop k oblikovanju koledarja, 

ki združuje funkcionalnost in estetsko privlačnost. Diplomsko delo bo temeljilo na analizi 

obstoječih koledarjev, preučevanju sodobnih trendov v oblikovanju ter vključevanju 

povratnih informacij uporabnikov, z namenom ustvariti koledar, ki bo služil tako 

praktičnemu kot dekorativnemu namenu, prilagojen potrebam ciljnih kupcev. 

Cilji diplomskega dela: 

• Raziskati zgodovino in različne vrste koledarjev. 

• Preučiti sodobne trende v grafičnem oblikovanju koledarjev. 

• Raziskati osnovne principe grafičnega oblikovanja, ki so pomembni pri ustvarjanju 

koledarja, vključno z barvno shemo, tipografijo in postavitvijo. 

• Izvesti tehnično realizacijo oblikovanja koledarja. 

• Pripraviti datoteko za tisk ter zagotoviti tehnično pravilnost in kakovost končnega 

izdelka. 

• Oceniti uspešnost končnega izdelka in predlagati možnosti za nadaljnji razvoj. 
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3 Raziskovalne hipoteze 

V diplomski nalogi se bomo posvetili petim trditvam, predstavljenim v naslednjih hipotezah: 

H1: Zgodovinski razvoj koledarjev je vplival na oblikovanje sodobnih koledarjev, pri čemer 

sodobni koledarji še vedno vključujejo elemente tradicionalnih sistemov, kot so mesečne in 

tedenske razdelitve. 

Sodobni koledarji ohranjajo osnovne strukture, kot so mesečne in tedenske enote, ki izhajajo 

iz zgodovinskih koledarskih sistemov (npr. julijanski in gregorijanski koledar). Te 

tradicionalne strukture so se obdržale zaradi njihove praktičnosti pri organiziranju časa in 

usklajevanju z drugimi sistemi. Kljub tehnološkemu napredku in dodatnim funkcionalnostim, 

kot so digitalne sinhronizacije, osnovna oblika mesecev in tednov ostaja nespremenjena. (1) 

H2: Koledarji, ki vključujejo personalizirane vsebine, povečujejo njihovo funkcionalnost in 

uporabniško zadovoljstvo v primerjavi s standardnimi koledarji. 

Personalizirani koledarji povečujejo funkcionalnost in uporabniško zadovoljstvo, ker 

omogočajo prilagajanje vsebin, kot so osebne fotografije in pomembni datumi. To ustvarja 

čustveno povezanost, boljšo organizacijo in večjo angažiranost. Poleg tega se estetsko 

prilagajajo osebnemu okusu, kar izboljšuje celotno uporabniško izkušnjo v primerjavi s 

standardnimi koledarji (2). 

Prednosti personaliziranih koledarjev v primerjavi s standardnimi koledarji so bile 

obravnavane v več raziskavah in člankih. Na primer, študije o prilagajanju izdelkov kažejo, 

da personalizacija močno povečuje zadovoljstvo uporabnikov, saj se bolj povezujejo z 

izdelkom, kar povečuje njihovo angažiranost in verjetnost ponovnega nakupa.  

H3: Koledarji, ki vključujejo vizualne in funkcionalne elemente, kot so grafični elementi in 

prostori za opombe, so bolj uspešni pri doseganju ravnotežja med estetsko privlačnostjo in 

funkcionalnostjo kot tisti, ki se osredotočajo samo na enega od teh vidikov. 

Raziskave kažejo, da vizualno privlačni izdelki pritegnejo pozornost uporabnikov, medtem 

ko funkcionalni elementi, kot so prostori za opombe, izboljšajo praktično vrednost izdelka. 

Uporaba obeh pristopov skupaj vodi do izdelka, ki je ne le vizualno privlačen, ampak tudi 

izjemno uporaben. To povečuje uporabniško angažiranost, saj estetsko zadovoljstvo 

spodbuja redno uporabo, medtem ko funkcionalni elementi omogočajo boljšo organizacijo 

in produktivnost. Takšno ravnotežje med estetiko in funkcionalnostjo je ključno za uspeh na 

trgu, kjer potrošniki cenijo tako praktičnost kot vizualno privlačnost izdelkov. (3) 

H4: Uporaba naprednih grafičnih programov, kot sta Adobe Photoshop in Adobe Illustrator, 

vodi k bolj profesionalnemu videzu in višji kakovosti končnih koledarskih izdelkov v 

primerjavi z osnovnimi oblikovalskimi orodji. 

Uporaba naprednih grafičnih programov, kot sta Adobe Photoshop in Adobe Illustrator,  vodi 

k bolj profesionalnemu videzu in višji kakovosti končnih koledarskih izdelkov v primerjavi 

z osnovnimi oblikovalskimi orodji. Ti programi omogočajo visoko stopnjo natančnosti, 
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fleksibilnosti in kreativnosti pri oblikovanju. Z naprednimi funkcijami, kot so prilagojena 

barvna korekcija, kompleksne oblike, teksture, filtri in možnosti za delo s plastmi, lahko 

oblikovalci ustvarijo estetsko dovršene in vizualno privlačne koledarje. 

Adobe Photoshop je še posebej primeren za obdelavo slik in fotografij, kar omogoča, da so 

vizualni elementi koledarjev izjemno kakovostni.  

Adobe Illustrator pa je idealen za delo z vektorskimi grafikami, kar zagotavlja, da so grafični 

elementi jasni in brez izgube kakovosti ne glede na velikost tiskanja. 

V nasprotju s tem so osnovna orodja, kot so npr. Microsoft Word ali Canva, omejena v svoji 

funkcionalnosti in ne omogočajo enake stopnje natančnosti in prilagajanja, kar lahko vodi do 

manj profesionalnih rezultatov. Napredna programska oprema omogoča tudi boljšo pripravo 

na tisk, kar je ključno za visokokakovostne tiskane izdelke. (3) 

H5: Koledarji, ki vključujejo fotografije, specifične za letne čase, povečujejo uporabniško 

zadovoljstvo, saj te slike bolje odražajo sezonske spremembe in izboljšajo vizualno izkušnjo. 

Koledarji, ki vključujejo fotografije, specifične za letne čase, povečujejo uporabniško 

zadovoljstvo, saj te slike bolje odražajo sezonske spremembe in s tem izboljšajo vizualno 

izkušnjo. Takšni koledarji omogočajo uporabnikom, da se bolj povežejo s časovnim 

obdobjem, v katerem so, saj fotografije, ki odražajo trenutni letni čas, prispevajo k bolj 

čustveni in estetski izkušnji. Raziskave v oblikovanju in potrošniškem vedenju potrjujejo, da 

so uporabniki bolj zadovoljni z izdelki, ki vizualno usklajujejo sezonske spremembe, saj te 

vizualne podobe vzbujajo pozitivne čustvene odzive in povečujejo angažiranost z izdelkom. 

To je še posebej pomembno pri koledarjih, kjer je vizualna privlačnost ključna za 

vsakodnevno uporabo. (2) 
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4 Pregled dosedanjih raziskav in objav 

Oblikovanje koledarjev je področje, ki združuje številne aspekte, od zgodovinskih korenin in 

funkcionalnih zahtev do sodobnih oblikovalskih trendov in inovacij. V tem diplomskem delu 

bomo podrobno raziskali dosedanje raziskave in objave, ki so se osredotočale na različne 

vidike oblikovanja koledarjev. 

Pregled bomo začeli z analizo zgodovine in evolucije koledarjev, da bi razumeli njihove 

korenine in razvoj skozi čas. Osredotočili se bomo na osnovne funkcionalne značilnosti 

koledarjev, ki so vplivale na njihovo zasnovo in uporabo. 

Nato bomo preučili različne vrste koledarjev glede na format, vrsto pregleda, namen uporabe 

ter vsebino. S tem bomo izvedeli, kako se različne oblike in vsebine prilagajajo potrebam 

uporabnikov. 

V nadaljevanju bomo analizirali metode in pristope, uporabljene v grafičnem oblikovanju 

koledarjev. Posebno pozornost bomo namenili estetskim in funkcionalnim vidikom 

oblikovanja ter kako ti vplivajo na uporabniško izkušnjo in učinkovitost koledarjev. 

Na koncu bomo pregledali sodobne trende in inovacije v oblikovanju koledarjev, vključno z 

vplivom novih tehnologij in sprememb v uporabniških preferencah.  

 

4.1 Definicija koledarja 

“koledár -ja m (á)  

1. sistematična razdelitev leta na dneve, tedne in mesece: pomanjkljivosti obstoječega 

koledarja 

2. list, več listov (papirja) z razdelitvijo leta na dneve, tedne in mesece, navadno s podatki o 

luninih menah, praznikih: obesiti koledar na steno; zapisati podatek na koledar / namizni, 

stenski, žepni koledar; stoletni koledar s podatki za najmanj sto let 

3. publ., navadno s prilastkom razpored, red: pripravili so natančen koledar tekmovanj v 

zimski sezoni / izdelati koledar cvetenja medovitih rastlin” (SSKJ) (4) 
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4.2 Zgodovina koledarja 

Koledarji so skozi zgodovino igrali ključno vlogo pri beleženju časa in načrtovanju 

dejavnosti. Prvi koledarji so se pojavili že v starih civilizacijah, v Mezopotamiji, Egiptu ter 

na Kitajskem. Vsaka kultura je razvila svoj način merjenja časa, ki je temeljil na opazovanju 

naravnih ciklov, kot so sončni in lunini cikli. (5) 

4.2.1 Egipčanski koledar  (približno 3000 pr. n. št.) 

Egipčani so razvili enega izmed prvih znanih koledarjev, ki je temeljil na lunarnem ciklu in 

opazovanju Nila. Egipčanski koledar je imel 12 mesecev po 30 dni, dodanih pa je bilo še 5 

dni, da bi uskladili koledar z letnim obdobjem. (1) 

 

Slika 1: Egipčanski koledar 

(6) 

4.2.2 Babilonski koledar (približno 2000 pr. n. št.) 

Babilonski koledar je bil lunaren in je temeljil na fazah lune. Babilonci so uporabljali koledar 

z 12 meseci, pri čemer je vsak mesec trajal približno 29,5 dni. Da bi uskladili koledar z letom, 

so dodajali prestopne mesece. (1) 

4.2.3 Grški koledar (približno 800 pr. n. št.) 

Grški koledarji so se razlikovali med različnimi mesti-državami (polis). Atene so uporabljale 

lunisolarni koledar, ki je vseboval 12 mesecev po 29 ali 30 dni, z dodajanjem prestopnih 

mesecev za usklajevanje s sončnim letom. (1) 
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4.2.4 Rimski koledar (približno 753 pr. n. št.) 

Izvirni rimski koledar je bil lunaren in je imel 10 mesecev. Kasneje je bil reformiran v 

julijanski koledar pod Julijem Cezarjem (46 pr. n. št.), ki je uvedel 365-dnevno leto z 

dodatnim prestopnim dnem vsakih štiri leta, kar je bil pomemben korak k modernemu 

koledarju. (1) 

 

Slika 2: Rimski koledar 

(7) 

4.2.5 Gregorijanski koledar (1582 n. št.) 

Da bi odpravili napake v julijanskem koledarju, ki so se nakopičile skozi stoletja, je papež 

Gregor XIII. uvedel gregorijanski koledar. Ta sistem je izboljšal natančnost letnega cikla s 

prilagoditvijo pravil za prestopna leta. Gregorijanski koledar je postal mednarodni standard 

in je nadomestil julijanski koledar v večini katoliških držav. (1) 

 

Slika 3: Reforma gregorijanskega koledarja 

(8) 
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4.3 Vrste koledarjev   

Koledarji so se skozi čas razvijali, da bi zadovoljili različne potrebe uporabnikov. Danes 

poznamo številne vrste koledarjev, ki se razlikujejo glede na njihov format, namen in način 

uporabe. Tri priljubljene vrste koledarjev so stenski, namizni in žepni koledarji. Vsaka vrsta 

ima svoje posebnosti in prednosti. (5) 

4.3.1 Stenski koledar 

Stenski koledar je koledar, ki se običajno pritrdi na steno, kar omogoča enostavno 

pregledovanje časa. Ima lahko različne oblike in velikosti, vendar so najbolj uporabljeni 

pokončni ali ležeči formata A3 ali A4. Večinoma so tiskani na papir ali karton, z ojačanim 

ozadjem iz lepenke. Ponavadi vključuje mesečne ali letne prikaze, kjer so vsi dnevi enega 

meseca prikazani na eni strani. Nekateri imajo lahko umetniške slike, fotografije ali 

ilustracije. V koledarskem delu je najbolj izpostavljeno ime meseca, za njim pa dnevi in 

seveda datumi. Nekateri imajo označene tudi praznike in lunine mene. (6 str. 346-348) 

Stenski koledar je primeren za pisarne, domove in javne prostore, kjer je potreben velik in 

enostavno dostopen pregled koledarskih informacij. Stenski koledarji pogosto služijo tudi 

kot dekorativni elementi.  

Njihova prednost je, da omogočajo enostaven pregled mesecev in dni naenkrat, imajo veliko 

površino za označevanje pomembnih datumov, dogodkov ali opomnikov. 

 

Slika 4: Primer stenskega koledarja 

(10) 
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4.3.2 Namizni koledar 

Namizni koledar je manjši koledar, zasnovan za postavitev na pisarniško mizo, pisalno mizo 

ali drugo delovno površino. Namizni koledarji so pogosto mesečni ali tedenski. Ponavadi so 

manjših formatov A6 ali A5, s papirjem, ki omogoča zapisovanje z vsemi vrstami pisal. 

Vezani so različno, največkrat so vpeti v lesene, kartonaste, kovinske ali plastične nosilce in 

imajo liste spete z žico, plastično ali kovinsko spiralo ali pa celo s kovinskimi obroči in 

polobroči. Narejeni so tako, da jih lahko postavimo npr. na mizo. (6 str. 346-348) 

Idealni so za osebno uporabo v pisarni ali doma, saj omogočajo enostaven dostop do 

koledarskih informacij in prostora za osebne opombe.  

Njegove prednosti so, da je kompakten in priročen za uporabo na delovni površini, pogosto 

vključuje dovolj prostora za dodatne zapiske in opomnike, lahko vključuje tudi informacije, 

kot so kontaktne številke ali koledarji prejšnjih in naslednjih let. 

 

Slika 5: Primer namiznega koledarja 

(11) 
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4.3.3 Žepni koledar 

Žepni koledar je majhen, prenosni koledar, ki se pogosto prilega v žep, torbico ali denarnico. 

Zasnovan je tako, da je enostaven za prenašanje in hitro dostopanje. Običajno ima mesečne 

ali tedenske prikaze, vendar v manjšem formatu. Vsebuje osnovne koledarske podatke, 

včasih pa tudi prostor za kratke zapiske. (6 str. 346-348) 

Žepni koledar je idealen za osebno uporabo, ko je potrebno imeti koledar vedno pri sebi.  

Prednost je, da je zelo prenosljiv, primeren za hitro dostopanje do koledarskih informacij, 

enostavno prilegajoč v majhne torbice ali žepke. 

 

Slika 6: Primer žepnega koledarja 

(12) 
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4.4 Grafično oblikovanje 

Grafično oblikovanje je kompleksna disciplina, ki združuje umetnost, tehnologijo in 

komunikacijo. Razumevanje osnovnih konceptov in teorij, ki stojijo za tem področjem, je 

ključno za uspešno izvajanje oblikovalskih nalog. (3) 

4.4.1 Tipografija 

Tipografija je umetnost in znanost o oblikovanju besedila, kar vključuje izbiro pisav, 

velikosti pisave, postavitve in razmikov med črkami ter vrsticami. Je ena od temeljnih 

komponent grafičnega oblikovanja in igra ključno vlogo pri oblikovanju berljivosti in 

estetske privlačnosti dokumentov. (7 str. 11) 

• Izbira pisave: Pisave (fonti) lahko močno vplivajo na zaznavanje besedila. Pisave se 

delijo na serifne (npr. Times New Roman) in brezserifne (npr. Arial). Serifne pisave so 

pogosto povezane s formalnostjo in tradicijo, medtem ko so brezserifne pisave moderne 

in enostavnejše za branje na digitalnih zaslonih. (8) 

 

Slika 7: primer serifne in brezserifne pisave 

(15) 

 

• Hierarhija besedila: Hierarhija besedila se doseže z uporabo različnih velikosti pisave, 

teže (krepke, navadne), sloga (kurziv) in barv. Naslovi in podnaslovi so tako vidno ločeni 

od glavnega besedila, kar omogoča bralcu enostavno navigacijo po vsebini. (8) 

 

• Razmik in poravnava: Razmik med črkami (kerning) in vrsticami (leading) vpliva na 

berljivost besedila. Premajhen razmik lahko povzroči težave pri branju, medtem ko 

prevelik razmik zmanjša kohezijo besedila. Poravnava besedila (leva, desna, sredinska 

ali obojestranska) prav tako vpliva na vizualni vtis in berljivost. (8) 

 

• Konsistentnost: Pomembno je, da se pri oblikovanju besedila upošteva konsistentnost. 

Uporaba enakih pisav in stilov za podobne vsebine prispeva k profesionalnemu in 

usklajenemu videzu. (8) 



Špan, P. 2024. Oblikovanje koledarja za Facebook skupino “Železniški navudešenci” za leto 2024. Šola za 

hortikulturo in vizualne umetnosti Celje, Višja strokovna šola. 

 

  

 

12 

 

 

4.4.2 Barve 

Barve v grafičnem oblikovanju igrajo ključno vlogo pri prenosu sporočil in oblikovanju 

vizualne identitete. Razumevanje osnovnih načel barvne teorije je nujno za uspešno 

oblikovanje. Barve lahko povzročijo različne emocionalne odzive in vplivajo na zaznavanje 

blagovne znamke. (8) 

Pri izbiri barv je pomembno upoštevati naslednje dejavnike: 

• Barvni krog in harmonija: Barvni krog prikazuje osnovne barve in njihove kombinacije. 

Harmonične barvne sheme, kot so komplementarne, analogne in triadne kombinacije, 

lahko ustvarijo vizualno privlačne in uravnotežene dizajne. (8) 

 

Slika 8: Barvni krog 

(16) (17) 

• Psihologija barv: Barve imajo psihološki vpliv na gledalce. Na primer, modra barva 

lahko sprošča občutke zaupanja, medtem ko rdeča lahko vzbudi občutke strasti ali 

urgence. Rumena je svetla in vesela barva, povezana z optimizmom in srečo. Lahko 

povečuje raven energije in pozornosti.  Zelena  je pogosto povezana z naravo in obnovo, 

lahko zmanjšuje stres in spodbuja občutek ravnotežja, oranžna pa spodbuja kreativnost 

in socialno interakcijo, lahko pa tudi povzroči občutek pomanjkanja miru, če je preveč 

intenzivna. (8) 
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• Barvni modeli:  

 

RGB (rdeča, zelena, modra) je standardni barvni model za vse vrste digitalnih zaslonov, 

kot so računalniški monitorji, televizorji, pametni telefoni in tablični računalniki. To je 

zato, ker RGB model temelji na emisiji svetlobe in je idealen za zaslone, ki uporabljajo 

svetlobo za prikaz barv. RGB barvni model deluje tako, da uporablja rdečo, zeleno in 

modro svetlobo v različnih kombinacijah za ustvarjanje širokega spektra barv. Barve so 

ustvarjene s seštevanjem teh treh osnovnih barv svetlobe v različnih intenzitetah. (7 str. 

87) 

 

CMYK (cian, magenta, rumena, črna) je standardni barvni model za tiskanje na papirju. 

To je zato, ker tiskalniki uporabljajo barve v črnilih, ki se mešajo na fizičnem mediju, da 

ustvarijo končne barve. Vse tiskane materiale, kot so knjige, revije in promocijski 

materiali, običajno uporabljajo CMYK model za barvno reprodukcijo. Deluje tako, da se 

barve mešajo z nanosi črnila na papirju, kjer so različne barve ustvarjene z mešanjem teh 

osnovnih barv. (7 str. 87) 

 

Slika 9: RGB in CMYK 

(17) 

Pantone sistem je pogosto uporabljen, kadar je potrebno doseči točno določeno barvo, 

ki je enaka v vseh tiskanih materialih in na različnih medijih. To je še posebej pomembno 

za blagovne znamke, ki želijo ohraniti doslednost barv. Vsaka Pantone barva je označena 

s številko, kar omogoča dosledno reprodukcijo barve v različnih tiskarskih delavnicah in 

na različnih medijih. (7 str. 87) 

 

• Kontrast in berljivost: Kontrast med besedilom in ozadjem je ključen za berljivost. 

Uporaba kontrastnih barv lahko poveča vidnost in omogoči enostavno branje besedila. 

Za najboljšo berljivost je priporočljivo, da je kontrast med besedilom in ozadjem čim 

višji. Na primer, črno besedilo na belem ozadju ali belo besedilo na črnem ozadju 

zagotavlja maksimalen kontrast. 
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4.4.3 Fotografija 

Fotografija je pomembna sestavina grafičnega oblikovanja, saj prispeva k vizualni 

privlačnosti in komunikaciji informacij. Uporaba kakovostnih fotografij lahko izboljša 

celoten dizajn in poveča njegovo učinkovitost. (8) 

• Kakovost fotografij: Visokokakovostne slike zagotavljajo profesionalen videz in 

povečajo verodostojnost. Slike z nizko ločljivostjo ali slabo kakovostjo lahko zmanjšajo 

učinkovitost dizajna in negativno vplivajo na percepcijo blagovne znamke. Za tiskane 

fotografije je priporočena ločljivost vsaj 300 DPI (dots per inch). To zagotavlja, da so 

detajli ostri in fotografija ni zamegljena. (3) 

 

• Kompozicija: Kompozicija slike vključuje postavitev elementov, svetlobo, barve in 

perspektivo. Načela kompozicije, kot je pravilo tretjin, pomagajo pri ustvarjanju 

uravnoteženih in vizualno privlačnih slik. (3) 

 

 

Slika 10: Primer pravila tretjin 

(18) 

 

• Usklajenost s sporočilom: Fotografije morajo biti v skladu s sporočilom, ki ga želite 

prenesti. Nepravilno izbrane slike lahko povzročijo zmedo ali odvračajo pozornost od 

ključnih informacij. (3) 

 

• Avtorske pravice: Uporaba fotografij brez ustreznih pravic ali dovoljenj lahko privede 

do pravnih težav. Pomembno je, da so urejene pravice za uporabo slik, bodisi preko 

nakupa licenc bodisi z uporabo lastnih fotografij. (3) 
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4.4.4 Tabelarični stavek 

Tabelarični stavek se nanaša na predstavitev informacij v tabelah, kar omogoča enostavno 

organizacijo in primerjanje podatkov. (3) 

• Jasna struktura: Tabele morajo biti oblikovane tako, da so informacije enostavno 

razumljive. To vključuje dosledno uporabo stolpcev in vrstic, jasne oznake ter ustrezne 

robove. 

 

• Poudarjanje podatkov: Ključni podatki v tabelah lahko postanejo bolj opazni z uporabo 

poudarkov, kot so krepka pisava ali barvni označevalci. Pomaga pri hitrosti iskanja in 

primerjanja podatkov. 

 

• Berljivost: Razmiki med stolpci in vrsticami, pa tudi velikost pisave, morajo biti 

primerni, da zagotovijo, da je tabela enostavna za branje. Premajhen razmik lahko 

povzroči zmedo in težave pri branju. 

 

• Uporabnost: Tabele morajo biti zasnovane z mislijo na uporabnika. Pomembno je, da so 

podatki enostavno dostopni in primerljivi ter da so informacije v tabelah predstavljene v 

jasni in pregledni obliki. 

 

Slika 11: Primer tabelaričnega stavka 

(19) 
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4.4.5 Postavitev 

Postavitev (layout) se nanaša na način, kako so različni oblikovalski elementi, kot so besedilo, 

slike in grafike, organizirani na strani. Dobra postavitev omogoča učinkovito komunikacijo 

in estetsko privlačnost. (9) 

• Prostorsko ravnotežje: Razdelitev prostora med različnimi elementi mora biti 

uravnotežena, da se prepreči prenasičenost in zagotovi vizualna harmonija.  

 

• Usmerjanje oči: Oblikovanje mora voditi oči bralca skozi dokument na način, ki je 

naraven in logičen. To vključuje postavitev elementov na način, ki vodi bralca od enega 

dela dokumenta do drugega. 

 

• Fleksibilnost: Postavitev mora biti prilagodljiva različnim formatom in velikostim 

medijev, bodisi za tisk bodisi za digitalne platforme.  

 

4.4.6 Vizualna hierarhija 

Vizualna hierarhija je načelo oblikovanja, ki pomaga usmerjati gledalčevo pozornost in jasno 

prenesti informacije. Gre za način razporeditve in oblikovanja elementov na strani, tako da 

se najpomembnejše informacije prikažejo najprej in najbolj izstopajo. (9) 

• Velikost: Velikost elementa pogosto določa njegov pomen. Večji elementi, kot so naslovi 

ali ključni vizualni elementi, običajno pritegnejo več pozornosti kot manjši.  

 

• Barva: Barva je močno orodje pri vzpostavljanju hierarhije. Svetlejše ali kontrastnejše 

barve ponavadi pritegnejo več pozornosti.  

 

• Teža pisave: Uporaba različnih debelin pisav (krepko, običajno, tanko) prispeva k 

vizualni hierarhiji. Krepke pisave običajno označujejo bolj pomembne informacije, 

medtem ko tanjše ali običajne pisave služijo kot spremljevalno besedilo. 

 

• Prostorska razporeditev: Postavitev elementov na strani vpliva na to, kako jih zaznamo. 

Elementi, postavljeni na vrh ali v središče strani, ponavadi pritegnejo več pozornosti kot 

tisti, ki so ob strani ali na dnu. 

 

• Praznina (bela površina): Uporaba praznine okoli ključnih elementov lahko poveča 

njihov pomen. Praznina omogoča elementom, da "dihajo", kar preprečuje prenasičenost 

strani in pomaga pri usmerjanju pozornosti na pomembne dele oblikovanja.                                                    

 

• Poravnava: Poravnava elementov ustvarja red in doslednost, kar pomaga gledalcu pri 

navigaciji po vsebini. Na primer, sredinska poravnava naslovov lahko ustvari občutek 

ravnotežja, medtem ko leva poravnava besedila omogoča lažje branje. 
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4.4.7 Priprava za tisk 

Priprava za tisk je eden izmed zadnjih, a ključnih korakov v procesu grafičnega oblikovanja, 

ki zagotavlja, da bo končni izdelek videti točno tako, kot je bilo zamišljeno na zaslonu. (10) 

• Preverjanje ločljivosti: Slike in grafike morajo imeti zadostno ločljivost za tisk, 

običajno vsaj 300 DPI (točk na palec), da se prepreči zamegljenost ali pikselizacija. Slike 

z nižjo ločljivostjo, primerne za splet, pogosto ne bodo dovolj kakovostne za tisk. (11) 

 

Slika 12: Preverjanje ločljivosti fotografije v programu Adobe Photoshop 

(23) 

 

• Nastavitev barvnega profila: Digitalni in tiskani mediji uporabljajo različne barvne 

modele. Medtem ko zasloni uporabljajo RGB, tiskanje uporablja CMYK. Preveriti je 

treba barvni profil datotek, da se zagotovi pravilno prikazovanje barv pri tiskanju. (11) 

 

 

Slika 13: Urejanje barvnega profila v programu Adobe Illustrator 

(24) 
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• Bleed: Bleed so dodatni robovi (običajno 3 mm), ki segajo čez meje končnega formata 

tiskanega izdelka. Ti omogočajo, da barva ali slika seže vse do roba papirja po 

obrezovanju. (11) 

 

 

 Slika 14: Določanje bleeda v program Adobe Illustrator 

(25) 

 

• Obrezne črte (Crop marks): Obrezne črte označujejo, kje bo stran obrezana. Te črte so 

običajno postavljene zunaj dejanske velikosti strani in se odstranijo po obrezovanju. (11) 

 

 

Slika 15: Prikaz bleeda in obreznih črt 

(26) 
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• Preverjanje pisav: Pred tiskom je treba preveriti, ali so vse uporabljene pisave v 

dokumentu pravilno pripravljene in spremenjene v krivulje. Če pisave niso spremenjene 

v krivulje, lahko pride do težav pri tiskanju, saj lahko tiskar uporablja nadomestne pisave, 

kar spremeni videz dokumenta. (11) 

 

 

   Slika 16: Ustvarjanje krivulj v programu Adobe Illustrator 

(27) 

 

• Formati datotek: Pri pripravi za tisk je pomembno izbrati pravi format datoteke. 

Najpogosteje uporabljeni formati so: 

PDF: PDF je standardni format za tisk, saj ohranja postavitev, pisave, barve in slike v 

nespremenjenem stanju. PDF-ji, ki so pripravljeni za tisk, običajno vključujejo bleed in 

obrezne črte. 

TIFF: TIFF je format, ki se uporablja za slike visoke ločljivosti brez stiskanja. Primeren 

je za tiskanje kakovostnih fotografij in ilustracij. 

EPS: EPS je format, ki se uporablja za vektorske grafike. Je idealen za logotipe in druge 

elemente, ki morajo biti tiskani v katerikoli velikosti brez izgube kakovosti. (7 str. 205) 

 

 

Slika 17: Shranjevanje datoteke kot PDF, pripravljen za tisk 

 (28) 
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4.4.8 Papir in vezava 

Papir in vezava sta zadnja koraka v procesu grafičnega oblikovanja, vendar imata velik vpliv 

na končni izdelek. Pravilna izbira papirja in ustrezne tehnike vezave lahko dvigneta kakovost 

in trajnost tiskanega materiala, hkrati pa izboljšata uporabniško izkušnjo. (11) 

• Vrste papirja: Izbor pravega papirja je odvisen od namena in narave tiskanega izdelka.  

Premazni papir (Coated Paper): Primeren je za koledarje z visoko kakovostnimi 

fotografijami, saj sijajna površina dodaja globino in intenzivnost slikam. Vendar lahko 

sijajni premaz povzroči odseve, kar včasih otežuje branje besedila. 

Nepremazni papir (Uncoated Paper): Nepremazni papir ima naravno, rahlo hrapavo 

površino, ki je manj odbojna in bolj vpojna, kar je primerno za koledarje, kjer je poudarek 

na pisanju ali beleženju. Ta papir zagotavlja prijeten občutek pri dotiku in je idealen za 

koledarje, ki vključujejo pisanje, kot so stenski koledarji z veliko prostora za beležke.  

 

Slika 18: Primer fotografije na premaznem in nepremaznem papirju 

(29) 

 

• Teža papirja: Teža papirja, merjena v gramih na kvadratni meter (g/m²), vpliva na 

trdnost, trajnost in občutek papirja: 

Lahki papir (60–90 g/m²): Uporablja se za pisarniški papir, pisma in notranje strani 

knjig. 

Srednje težki papir (90–170 g/m²): Primeren je za revije, brošure, letake in plakate. 

Pogosto se uporablja za koledarje z več stranmi. 

Težji papir (170–300 g/m²): Pogosto se uporablja za naslovnice revij, vizitke in hrbtne 

strani koledarjev. 

Kartoni (nad 300 g/m²): Uporabljajo se za platnice knjig in druge izdelke, ki zahtevajo 

večjo togost in trdnost. 
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• Vezava: Vezava je proces združevanja posameznih strani v enotno publikacijo. Pri 

koledarjih je vezava ključnega pomena, saj mora omogočati enostavno obračanje strani 

in hkrati zagotoviti, da koledar ostane trden skozi vse leto. Obstaja več vrst vezav, ki se 

pogosto uporabljajo za koledarje: (9) 

Spiralna vezava: Je najpogosteje uporabljena pri koledarjih. Strani koledarja so 

preluknjane vzdolž zgornjega roba in nato povezane s kovinsko ali plastično spiralo. Ta 

vrsta vezave omogoča, da se koledar enostavno odpre, obrne in visi na steni. Spirala 

omogoča tudi, da koledar ostane raven, ko je odprt, kar je praktično za beleženje opomb 

ali pregledovanje datumov. 

 

 

Slika 19: Naprava za spiralno vezavo 

(30) 

 

O-Wire ali Wire-O vezava: je podobna spiralni, vendar uporablja dvojno žično vezavo, 

ki je še trdnejša in bolj stabilna.  

 

Slika 20: Primer spiralne in Wire-O vezave 

(31) 
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4.5 Programi za grafično oblikovanje 

Grafično oblikovanje zahteva uporabo napredne programske opreme, ki omogoča ustvarjanje, 

urejanje in obdelavo vizualnih elementov. Med najbolj uporabljene in razširjene programe 

za grafično oblikovanje sodita Adobe Photoshop in Adobe Illustrator. (7) 

4.5.1 Adobe Photoshop 

Adobe Photoshop je najbolj znana programska oprema za urejanje slik. (12) 

• Rastrska grafika: Photoshop je specializiran za delo z rastrsko grafiko, kar pomeni, da 

slike obdeluje kot mrežo pikslov. Rastri omogočajo natančno delo na slikah, vendar pa 

so omejeni, ko gre za spreminjanje velikosti, saj se lahko pri povečevanju izgubi kakovost. 

 

• Obdelava fotografij: Photoshop ponuja širok nabor orodij za obdelavo in retuširanje 

fotografij. To vključuje orodja za popravljanje barv, odpravljanje napak, spreminjanje 

kontrasta, svetlobe in druge prilagoditve, ki izboljšajo vizualno kakovost slik. 

 

• Napredno urejanje: Omogoča napredno manipulacijo slik, kot so ustvarjanje 

kompleksnih kompozicij, delo s sloji (layers), maskami, mešalnimi načini (blending 

modes) in naprednimi filtri.  

 

• Podpora za vektorsko grafiko: Čeprav je Photoshop predvsem rastrski program, 

podpira osnovno delo z vektorsko grafiko in ni najboljši za kompleksnejše vektorske 

projekte. 

4.5.2 Adobe Illustrator 

Adobe Illustrator je vodilna programska oprema za vektorsko grafiko, ki omogoča 

spreminjanje velikosti brez izgube kakovosti. (7 str. 10-19) 

• Vektorska grafika: Illustrator ustvarja vektorske grafike z matematičnimi enačbami, kar 

omogoča brezhibno spreminjanje velikosti brez izgube kakovosti, kar je idealno za 

logotipe, ikone in ilustracije. 

 

• Ustvarjanje ilustracij: Illustrator ponuja širok nabor orodij za risanje in oblikovanje, 

vključno s peresom (Pen Tool), krivuljami (Bezier curves), oblikami in naprednimi 

barvnimi orodji.  

 

• Tipografija: Omogoča natančno urejanje tipografije, ustvarjanje lastnih pisav (custom 

fonts) in uporabo besedila kot oblikovnega elementa. Orodja za tipografijo omogočajo 

prilagoditev oblik, razmikov in poravnave.  

 

• Delo s plastmi (Layers): Illustrator, tako kot Photoshop, omogoča delo s plastmi, kar 

olajša organizacijo in urejanje kompleksnih projektov. Plasti omogočajo ločeno urejanje 

različnih elementov ilustracije, kar povečuje produktivnost in natančnost. 
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4.6 Trendi v grafičnem oblikovanju za leto 2024 

Trendi v grafičnem oblikovanju koledarjev za leto 2024 odražajo nenehno spreminjanje 

estetskih preferenc, tehnoloških inovacij in družbenih vrednot. Personalizacija, trajnost, 

interaktivnost, minimalizem, umetniške ilustracije, tematski dizajn, kombinacija analognega 

in digitalnega ter drzni barvni kontrasti so ključni trendi za 2024. (12) 

4.6.1 Personalizacija in prilagodljivost 

Personalizacija koledarjev postaja vedno bolj priljubljena. Oblikovalci in uporabniki iščejo 

načine, kako prilagoditi koledarje svojim osebnim potrebam ali brandu podjetja. To vključuje 

vključitev osebnih fotografij, pomembnih datumov ali tematskih elementov, ki odražajo 

interesne skupine uporabnikov. (12) 

4.6.2 Interaktivni koledarji 

Interaktivni koledarji, ki vključujejo QR kode ali povezave do spletnih vsebin, postajajo vse 

bolj priljubljeni. Ti koledarji omogočajo uporabnikom, da z uporabo pametnih telefonov 

dostopajo do dodatnih informacij, kot so dogodki, posebne ponudbe ali izobraževalne 

vsebine. Interaktivne funkcionalnosti dodajajo vrednost koledarju in omogočajo bolj 

dinamično uporabniško izkušnjo. (12) 

 

Slika 21: Primer interaktivnega koledarja 

(33) 
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4.6.3 Sodobni minimalizem 

Minimalističen dizajn ostaja pomemben trend pri koledarjih. Preproste linije, čiste 

kompozicije in omejena barvna paleta pripomorejo k elegantnemu in preglednemu videzu. 

Minimalizem omogoča, da koledarji ostanejo funkcionalni in estetsko prijetni, brez 

nepotrebnih okrasnih elementov, kar povečuje njihovo uporabnost in dolgotrajno privlačnost. 

(12) 

 

Slika 22: Primer minimalističnega koledarja 

(34) 

 

4.6.4 Umetniške in ročno izdelane ilustracije 

Koledarji z ilustracijami pridobivajo na priljubljenosti. Te ilustracije pogosto vključujejo 

edinstvene umetniške sloge, kot so akvareli, risbe ali digitalno ustvarjene umetnine, ki dodajo 

osebno noto in estetsko vrednost. (12) 

4.6.5 Tematski in sezonski dizajn 

Tematski koledarji, ki sledijo določeni temi ali sezoni, so v letu 2024 še posebej priljubljeni. 

Tematski koledarji lahko vključujejo različne vizualne koncepte, kot so potovanja, narava, 

umetnost ali posebni dogodki. (12) 
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4.6.6 Poudarek na barvnih kontrastih in eksperimentiranju 

Neobičajne barvne kombinacije in uporabe, ki pritegnejo pozornost in dodajo dinamičnost 

koledarjem, so v trendu za leto 2024. Ta trend vključuje uporabo živih barv, gradientov in 

edinstvenih barvnih shem, ki prispevajo k vizualnemu učinku in privlačnosti koledarja. (12) 

 

Slika 23: Primer dinamično oblikovanega koledarja 

(35)  
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5 Raziskovalne metode 

Oblikovanje koledarja vključuje kompleksne raziskovalne in načrtovalne postopke, ki so 

ključni za zagotavljanje, da končni izdelek ustreza potrebam in željam ciljnih uporabnikov. 

Najprej bom izvedla anketo, da pridobim vpogled v preference in potrebe potencialnih 

uporabnikov. Nato bom opisala koncept in načrtovanje koledarja, kjer bom določila ciljne 

kupce, format, vezavo in vsebino koledarja ter vizualni koncept.  Nato bom opisala process 

oblikovanja koledarja, pri čemer bom upoštevala koncept in načrt, razvit v prejšnji fazi. Na 

koncu bom opisala tehnično izvedbo končnega oblikovanja in realizacijo končnega izdelka. 

Diplomsko delo je bilo pripravljeno na podlagi dejanskega projekta, ki se je izvajal konec 

leta 2023. Projekt je služil kot osnova za raziskovalno delo in analize, predstavljene v 

diplomskem delu. Vse ugotovitve in priporočila izhajajo iz praktičnih izkušenj in rezultatov, 

pridobljenih med izvedbo tega projekta. 

 

5.1 Anketni vprašalnik 

Za pridobitev vpogleda v preference in potrebe ciljnih uporabnikov pri oblikovanju koledarja 

sem se odločila izvesti anketo. Ankete so učinkovit način zbiranja podatkov, saj omogočajo 

neposredno pridobivanje mnenj in želja potencialnih uporabnikov ter zagotavljajo relevantne 

informacije za oblikovanje končnega izdelka. 

Namen ankete je bil raziskati, katere lastnosti in funkcionalnosti so za uporabnike 

najpomembnejše pri izbiri koledarja.  Za zbiranje podatkov sem uporabila spletno anketo, 

kar omogoča enostavno dostopnost in hitro pridobivanje odgovorov od širokega spektra 

anketirancev. Spletna anketa je bila distribuirana preko Facebook skupine, kar je pripomoglo 

k pridobivanju reprezentativnega vzorca. 

Za naš anketni vprašalnik smo izbrali vprašanja zaprtega tipa. Ta odločitev nam omogoča 

enostavno in hitro analizo podatkov, saj so odgovori omejeni na vnaprej določene možnosti, 

kar zagotavlja jasnost in natančnost rezultatov. Zaprta vprašanja omogočajo preprosto 

primerjavo odgovorov, kar nam pomaga pri učinkovitih in doslednih analizah. Poleg tega so 

takšna vprašanja hitra za izpolnjevanje, kar povečuje stopnjo odziva in zmanjšuje čas, 

potreben za zbiranje podatkov. 

V nadaljevanju bom predstavila rezultate ankete, ki bodo osvetlili ključne ugotovitve in 

vplivali na nadaljnje oblikovanje koledarja. Analiza teh rezultatov bo omogočila prilagoditev 

koncepta in vsebine koledarja v skladu z dejanskimi potrebami in preferencami uporabnikov. 
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5.1.1 Analiza anketnega vprašalnika 

1. Kakšen format koledarja vam najbolj ustreza? 

• Stenski koledar: 80 % (40 glasov) – Ta izbira je najbolj priljubljena, kar nakazuje, da 

večina anketirancev raje uporablja koledar, ki ga lahko enostavno postavi na steno in ima 

dobro vidnost. 

• Namizni koledar: 10 % (5 glasov)  

• Žepni koledar: 10 % (5 glasov)  

 

Graf 1: Kakšen format koledarja vam najbolj ustreza? 

(36) 

 

2. Kakšen format koledarja bi raje imeli? 

• A3 pokončen: 80 % (40 glasov) – Anketiranci preferirajo večji format koledarja v 

pokončni orientaciji, kar pomeni, da želijo več prostora za prikaz vsebine. 

• A3 ležeč: 20 % (10 glasov) – Manjši delež preferira širši format v ležeči orientaciji. 

 

Graf 2: Kakšen format koledarja bi raje imeli? 

(36) 
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3. Katere elemente bi želeli videti na koledarju? 

• Fotografije: 100 % (50 glasov) – Vsi anketiranci se strinjajo, da so fotografije najbolj 

zaželene, kar kaže na željo po vizualno privlačnem koledarju. 

• Klasična koledarska postavitev: 80 % (40 glasov) – Klasična postavitev je še vedno 

zelo cenjena, saj omogoča preprosto sledenje datumom. 

• Prazniki in pomembni datumi: 70 % (35 glasov) – Večina anketirancev želi vključitev 

praznikov in pomembnih datumov za boljše načrtovanje. 

• Ilustracije in grafike: 40 % (20 glasov) – Kljub temu da niso tako priljubljene kot 

fotografije, so ilustracije in grafike še vedno zaželene. 

• Citati ali motivacijska sporočila: 10 % (5 glasov) – Najmanjši delež želi vključitev 

citatov ali motivacijskih sporočil, kar nakazuje, da to ni glavna prednost pri večini 

uporabnikov. 

 

Graf 3: Katere elemente bi želeli videti na koledarju? 

(36) 

 

4. Katere barvne sheme se vam zdijo najprimernejše za koledar? 

• Temne in nevtralne barve: 60 % (30 glasov) – Temne barve so najbolj priljubljene, kar 

kaže na željo po bolj sofisticiranem dizajnu. 

• Svetle in živahne barve: 20 % (10 glasov) – Nekateri anketiranci imajo raje svetle in 

živahne barve za bolj dinamičen videz. 
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• Mehki, pastelni odtenki: 10 % (5 glasov) – Pastelni odtenki so najmanj priljubljeni, kar 

pomeni, da niso pogosto iskani. 

• Ni mi pomembno: 10 % (5 glasov) – Nekateri anketirianci niso občutljivi na barvne 

sheme, kar kaže na manjšo prioriteto pri izbiri barv. 

 

Graf 4: Katere barvne sheme se vam zdijo najprimernejše za koledar? 

(36) 

 

5. Kakšno tipografijo bi raje videli na koledarju? 

• Klasične in preproste pisave: 40 % (20 glasov) – Klasične pisave so najbolj priljubljene 

zaradi svoje berljivosti in enostavnosti. 

• Moderne in minimalistične pisave: 30 % (15 glasov) – Moderne pisave so prav tako 

priljubljene, kar kaže na trend po prečiščenem in sodobnem videzu. 

• Kreativne in unikatne pisave: 20 % (10 glasov) – Manjši delež anketirancev si želi bolj 

edinstvene pisave za dodaten vizualni učinek. 

• Mešanica različnih stilov: 10 % (5 glasov) – Najmanjši delež anketirancev je naklonjen 

mešanju različnih stilov pisav. 
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Graf 5: Kakšno tipografijo bi raje videli na koledarju? 

(36) 

 

6. Kako pomembno vam je, da koledar vsebuje dodatne funkcionalnosti? 

• Zelo pomembno: 50 % (25 glasov) – Polovica anketirancev meni, da so dodatne 

funkcionalnosti ključne, kar pomeni, da iščejo koledar, ki nudi več kot samo prikaz 

datumov. 

• Pomembno: 30 % (15 glasov) – Dodatne funkcionalnosti so še vedno pomembne za 

tretjino anketirancev, vendar niso ključnega pomena. 

• Ni pomembno: 10 % (5 glasov) – Manjši delež anketirancev ne daje velikega pomena 

dodatnim funkcionalnostim. 

• Ne želim dodatnih funkcionalnosti: 10 % (5 glasov)  

 

Graf 6: Kako pomembno vam je, da koledar vsebuje dodatne funkcionalnosti? 

(36) 
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5.2 Koncept in načrtovanje koledarja 

Cilj je ustvariti koledar, ki bo funkcionalen, estetsko privlačen in uporabnikom prijazen. 

Koledar je namenjen osebni uporabi in je ustvarjen za potrebe ciljne skpine.  

5.2.1 Definiranje ciljne skupine 

Ciljna skupina so člani Facebook skupine Železniški navdušenci. Skupina Železniški 

navdušenci je največja slovenska Facebook skupina za izmenjavo fotografij, 

videoposnetkov, člankov in razprav, tako strokovnih kot nestrokovnih, na temo železnice. 

Skupina je bila ustvarjena leta 2013, danes ima 17,3 tisoč članov. Povprečno število objav 

na mesec je 500, tako da bi lahko rekli, da je precej aktivna skupina. 

Skupina šteje 17,3 tisoč članov, pri čemer 24 % predstavljajo ženske in 76 % moški. Večina 

članov je v starostnem razponu med 25 in 65 let. Kljub raznolikosti članov, pa jih vse 

združuje skupen interes za železnice. Pri oblikovanju koledarja se torej ne bomo posebej 

prilagajali demografski strukturi članov, temveč bomo upoštevali njihov skupni interes. 

Potrebe in želje članov vključujejo vključitev njihovih fotografij ter zagotavljanje 

preglednosti in dovolj prostora za krajše zapiske na številčnici koledarja. 

 

Slika 24: Analiza članov skupine Železniški navdušenci 

(36) 

 

5.2.2 Določitev formata koledarja 

Vsak format ima svoje prednosti. Na primer, stenski koledarji so bolj vidni in priročni za 

vsakodnevno uporabo v pisarni ali doma, medtem ko so namizni koledarji pogosto bolj 

kompaktni in primerni za pisalne mize. Glede na potrebe članov skupine sem se odločila za 

pokončni A3 format, pri katerem je vsak mesec predstavljen na svoji strani. Mesečni 

koledarji so odlični za hitro pregledovanje celotnega meseca, hkrati pa imajo možnost 

dopisati krajše opombe. 
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5.2.3 Izbira vsebine 

Vsebina koledarja je ključnega pomena za njegovo funkcionalnost in privlačnost. Pomembno 

je, da je vsebina usklajena z namenom koledarja in potrebami ciljne skupine. 

Večina koledarjev vključuje osnovne informacije, kot so datumi, prazniki in pomembni 

dogodki. Edinstvenost tega koledarja pa bo v tem, da bo vsak mesec popestren s fotografijami 

vlakov.  

5.2.4 Vizualni koncept 

Vizualni koncept vključuje izbiro barv, tipografije, fotografij in splošnega dizajna. Vsi 

elementi – barve, tipografija, fotografije – morajo biti usklajeni in dopolnjujoči. Dober dizajn 

koledarja zagotavlja, da so vsi elementi harmonizirani in da koledar izgleda profesionalno in 

privlačno. 

• Barve morajo biti usklajene z namenom koledarja in morajo pritegniti pozornost ciljne 

skupine. Barve na koledarju bodo usklajene s fotografijami posameznih strani. 

 

• Tipografija vključuje izbiro pisav, njihovih velikosti, sloga in postavitve besedila. Dober 

izbor tipografije ne samo da izboljša berljivost, ampak tudi dopolnjuje vizualni stil 

koledarja. Stil koledarja bo minimalističen in sestavljen iz ravnih linij, zato bodo izbrane 

tipografije brezserifne. Pomembno je, da so glavni elementi koledarja, kot so datumi in 

pomembne informacije, jasno vidni in enostavni za branje. 

 

• Fotografije bodo izbrane preko natečaja članov skupine.  

 

• Dizajn koledarja bo minimalističen, sestavljen iz ravnih linij, pravokotnih oblik in 

brezserifnih tipografij.  

5.3 Proces oblikovanja 

V tej fazi bom začela z dejanskim oblikovanjem koledarja, pri čemer bom upoštevala koncept 

in načrt, razvit v prejšnji fazi. Proces oblikovanja bo potekal v več korakih. 

 

Slika 25: Inspiracija za oblikovanje koledarja 

(36) 
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5.3.1 Skiciranje 

Skiciranje je začetni korak v procesu oblikovanja koledarja, kjer preidejo ideje iz 

konceptualne faze v vizualne oblike. Ta faza je ključna za oblikovanje splošnega izgleda 

koledarja, saj omogoča raziskovanje različnih postavitev, stilov in elementov še pred 

začetkom digitalne obdelave. 

 

Slika 26: Skica postavitve 

(36) 
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5.3.2 Digitalno oblikovanje 

Digitalno oblikovanje je proces pretvorbe začetne skice v natančno digitalno verzijo, pri 

čemer se uporablja profesionalna programska orodja.   

• Izbira programske opreme: Adobe Illustrator je eden izmed najbolj pogosto 

uporabljenih programov za digitalno oblikovanje koledarjev zaradi svoje sposobnosti za 

natančno delo s vektorskimi grafiki. Uporabila sem ga za ustvarjanje in urejanje vseh 

vizualnih elementov koledarja. Za urejanje fotografij pa sem uporabila program Adobe 

Photoshop. (7 str. 32-64) 

 

 

Slika 27: Postavitev dokumenta v Adobe illustrator 

(36) 

 

Potek ustvarjanja dokumenta: Najprej odpremo Adobe Illustrator in izberemo "New 

Document" (Nov dokument). Za format Izberemo "A3" iz seznama prednastavljenih 

velikosti. Če A3 ni na voljo, lahko v ročnem vnosu vpišemo dimenzije: širina 29,7 cm, višina 

42 cm. Za orientacijo izberemo "Portrait" (Pokončno). Pod artboards (Delovne površine) 

vpišemo "14", da bomo imeli 14 delovnih površin v enem dokumentu. V polju "Bleed" 

vpišemo "0.3 cm". To zagotovi, da se tiskanje nadaljuje tudi čez robove dokumenta in 

prepreči bele robove po tisku. Preverimo, da je barvni prostor nastavljen na CMYK. To lahko 

nastavimo v oknu za "Advanced" (Napredno), kjer je pod "Color Mode" (Barvni način) 

izbran "CMYK Color". Resolucijo izberemo 300 ppi za zagotavljanje visoke kakovosti tiska.  

Po nastavitvi vseh teh parametrov kliknemo na "Create" (Ustvari), da začnemo z delom na 

dokumentu. (7 str. 32-64) 
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• Izbira fotografij: 

Za izbor fotografij, ki bodo vključene v koledar, je potekal natečaj v okviru Facebook skupine 

"Železniški navdušenci". Člani skupine so prispevali svoje lastne fotografije, ki so tematsko 

povezane z železnico. Fotografije so bile objavljene na Facebooku, kjer so uporabniki 

glasovali s pomočjo všečkov. Na podlagi tega je bilo izbranih 13 fotografij z največ všečki. 

• Naslovna fotografija: Fotografija, ki je prejela največ všečkov, bo uporabljena kot 

naslovna slika koledarja. 

• Razporeditev preostalih fotografij: Ostalih 12 fotografij, ki so bile med najbolj 

všečkanimi, so razporejene po mesecih. Razporeditev je prilagojena tematiki in slogu 

fotografij, tako da vsaka slika najbolje ustreza določenemu mesecu. Na primer, zimske 

slike se ujemajo z zimskimi meseci, spomladanske z meseci pomladi itd. 

 

Slika 28: Izbor fotografij za vsak mesec 

(36)  
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• Izbira tipografije: 

Tipografija Montserrat je priljubljena brezserifna pisava, ki jo je oblikovala argentinska 

oblikovalka Julieta Ulanovsky. Navdih zanjo je dobila v starih napisih, ki so se pojavili na 

urbanih plakatih in zgradbah v četrti Montserrat v Buenos Airesu. Glavne značilnosti 

tipografije Montserrat so: (8) 

Brezserifna pisava: Montserrat nima serifov, kar ji daje čist in moderen videz. Zaradi tega 

je enostavna za branje v različnih velikostih, kar je ključnega pomena za koledar, kjer mora 

biti besedilo pregledno in razumljivo na prvi pogled. Čiste linije in enostavnost pripomorejo 

k temu, da so datumi, dnevi in opisi hitro zaznavni. 

Sodobna in geometrijska: Črke so oblikovane z močnim poudarkom na geometrijskih 

oblikah, kar ji daje eleganten in uravnotežen videz. Okrogle oblike, kot so "O", "C" in "Q", 

so natančno krožne, kar prispeva k modernemu občutku. 

Debelina in variacije: Montserrat ponuja različne različice debeline (od tanke do zelo 

debele), kar omogoča široko uporabnost v oblikovanju. Lahko se uporablja za naslove ali 

poudarke v debelejši različici, medtem ko je v tanjši različici primerna za daljša besedila. 

Estetika: Tipografija je vizualno usklajena s celotnim modernim konceptom koledarja. S 

svojo preprostostjo prispeva k minimalističnemu in sodobnemu videzu, kar poudarja 

eleganco oblikovanja, ne da bi odvzemala pozornost od glavnega elementa – fotografij. 

 

Slika 29: Tipografija 

(36) 
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• Izbira barv: 

Barvna paleta za koledar je bila izbrana s pomočjo orodja kapalka (Eyedropper tool) v 

programu Adobe Illustrator, vsebuje močne in temne odtenke, ki imajo več ključnih lastnosti 

in pomenov za oblikovanje koledarja: (8) 

Močne barve: Barve, ki so žive in globoke, pritegnejo pozornost in ustvarjajo vizualno moč. 

Takšna paleta izstopa in dodaja izrazitost celotnemu oblikovanju. Močne barve omogočajo, 

da fotografije in drugi vizualni elementi na koledarju izstopajo, ne da bi se izgubili v preveč 

svetlih ali subtilnih tonih. 

Temni odtenki: Temnejši toni te palete prinašajo občutek resnosti, profesionalnosti in 

prefinjenosti. Temne barve so tudi prijazne do oči, še posebej v kombinaciji z enostavno in 

čitljivo tipografijo. To zagotavlja uravnoteženo oblikovanje, ki ni preveč vpadljivo, a je  

hkrati elegantno. 

Kohezija in kontrast: Barvni odtenki so izbrani tako, da med seboj dobro sodelujejo, a še 

vedno ustvarjajo kontrast. Ta kontrast omogoča poudarjanje ključnih elementov na koledarju. 

 

 

Slika 30: Barva paleta 

(36) 
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• Postavitev in usklajevanje elementov: 

1. Naslovnica: 

Na naslovni strani je prikazana velika fotografija z letnico 2024 in naslovom "KOLEDAR 

ŽELEZNIŠKI NAVDUŠENCI". Naslovna stran z zmagovalno fotografijo in jasnim napisom 

omogoča takojšnje prepoznavanje tematike in leta koledarja. Fotografija pritegne pozornost 

in predstavlja osrednji element, ki poveže vsebino koledarja. 

2. Meseci: 

Vsaka stran predstavlja en mesec, pri čemer je v zgornjem delu postavljena velika fotografija, 

ki zajema polovico strani, spodnji del pa je rezerviran za koledarski razpored dni. Fotografije 

so izbrane glede na tematiko in ustrezajo sezonskemu vzdušju posameznega meseca. To 

ustvarja vizualno povezavo med vsebino in mesecem ter hkrati omogoča, da koledar služi 

svojemu osnovnemu namenu. 

 

Slika 31: Postavitev enega meseca 

(36) 

 

3. Koledarski del: 

Koledarski del je na dnu vsake strani, z jasno postavljenimi številkami dni in dnevi v tednu. 

Letnica 2024 je postavljena ob strani, v pokončni smeri, kar prispeva k sodobnemu videzu. 

Koledar je pregledno oblikovan, številke dni so dovolj velike in jasne, kar omogoča 

enostavno branje in uporabo. Pokončna postavitev letnice omogoča, da ta element ne 

zavzame preveč prostora in se elegantno umešča ob strani. 
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4. Imena mesecev: 

Meseci so napisani v velikih, krepko izpisanih brezserifnih črkah (npr. JANUAR, 

FEBRUAR) in so umeščeni tik nad koledarskim delom. Imena mesecev so jasno vidna in 

pregledno umeščena. Krepkost in velikost pisave omogočata, da so meseci takoj prepoznavni, 

hkrati pa pisava ni preveč dominantna, saj ne odvrača pozornosti od fotografij. 

5. Barva in napisi: 

Vsak mesec ima barvno vrstico na dnu, ki ustreza specifični barvi, izbrani iz fotografije. 

Meseci imajo dodane opise in kredite avtorjem fotografij (avtorji so imeli možnost dodati 

svoj opis slike).  

6. Prostorska izkoriščenost: 

Prostorska razporeditev je uravnotežena, saj so fotografije dovolj velike, da pritegnejo 

pozornost, koledarski del pa zavzema ravno pravšnji prostor, da ne prekriva ali moti 

fotografij. Takšna razporeditev omogoča, da je koledar funkcionalen in estetsko privlačen. 

Fotografije ostajajo osrednji element, koledarski del pa je jasno viden, brez nepotrebne 

prenatrpanosti. 

 

Slika 32: Postavitev za vse mesece 

(36) 
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5.3.3 Priprava fotografij 

Priprava fotografije za tisk koledarja v Adobe Photoshop zahteva nekaj posebnih korakov, 

da zagotovimo visoko kakovost tiska, pravilno barvno upravljanje in ustrezno ločljivost.  

Začnemo tako, da fotografijo odpremo v Photoshopu: File > Open in izberemo fotografijo, 

ki jo želimo uporabiti. Za tisk koledarja potrebujemo ločljivost 300 dpi (dots per inch), kar 

zagotavlja visokokakovosten tisk. V Image > Image Size preverimo, ali je ločljivost 

nastavljena na 300 dpi. Če je nižja, jo prilagodimo na 300 dpi. Pri tem preverimo dimenzije 

slike (širina in višina), da zagotovimo, da je primerna za tisk (v tem primeru A3). (11) 

Za tisk je pomembno, da je slika v CMYK barvnem prostoru, saj večina tiskalnikov uporablja 

to barvno shemo. Preklopimo barvni način: Image > Mode > CMYK Color. Če želimo, 

lahko uporabimo Proof Colors (View > Proof Colors), da si ogledamo, kako bodo barve 

izgledale v CMYK.  

Fotografije v CMYK načinu lahko izgledajo manj živahno kot v RGB, zato jih lahko 

prilagodimo: 

Image > Adjustments > Levels: prilagodimo svetlost in kontraste, 

Image > Adjustments > Hue/Saturation: prilagodimo nasičenost barv.  

Na fotografiji lahko prilagodimo ostrino (Sharpening): pred tiskanjem rahlo povečamo 

ostrino slike, da bodo detajli pri tisku jasni: Filter > Sharpen > Unsharp Mask in 

prilagoditmo vrednosti: Amount: 100–150 %, Radius: 1–2 pikslov, Threshold: 0–2 (odvisno 

od podrobnosti na sliki). 

Končno sliko shranimo v formatu TIFF, saj ta format ohranja kakovost in omogoča visoko 

ločljivost. File > Save As in izberemo TIFF. Fotografijo nato lahko uvozimo v Illustrator. 

 

Slika 33: Priprava fotografij v Adobe Photoshop 

(37)  
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5.4 Tehnična realizacija 

V fazi tehnične realizacije koledarja se osredotočimo na konkretne korake, ki so potrebni za 

prevod oblikovalskega koncepta v fizični izdelek. To vključuje pripravo datotek za tisk, 

izbiro materialov, izvedbo testnega tiska in izdelavo končnega produkta. Vsak od teh korakov 

je ključnega pomena za zagotavljanje, da bo končni koledar ustrezal najvišjim standardom 

kakovosti in estetskih pričakovanj. (11) 

5.4.1 Priprava datotek za tisk 

Priprava datotek za tisk je ena izmed najpomembnejših faz v procesu tehnične realizacije, saj 

zagotavlja, da bo oblikovani koledar pravilno prenesen na tiskan medij. V tej fazi je treba 

upoštevati številne tehnične zahteve, ki vključujejo: (11) 

Preverjanje ločljivosti: Datoteke morajo biti pripravljene v zadostni ločljivosti ( 300 dpi), 

da se zagotovi jasnost in ostrina slik in besedila. 

Barvni prostor: Uporaba barvnega prostora CMYK je standard za tisk. Barve, ki se 

pojavljajo na zaslonu, se lahko razlikujejo od tistih na papirju, zato je pomembno, da se 

barvne nastavitve prilagodijo tiskarskim zahtevam. 

Obrezne oznake in bleeds: Dodajanje obreznih oznak in bleeds  zagotavlja, da ni belih robov 

ali nepravilnosti na končnem izdelku. Bleeds so običajno 3 mm, odvisno od zahtev tiskarne. 

Preverjanje besedila in slik: Temeljito preverjanje vseh besedil in slik v datotekah za tisk 

je nujno za preprečevanje napak. To vključuje preverjanje pravopisnih napak, kakovosti slik 

in skladnosti s konceptom oblikovanja. 

Shranjevanje datotek za tisk: Izberemo format PDF (Portable Document Format). To je 

najpogosteje uporabljen format za tiskanje, saj ohranja vse oblikovne elemente in barve ter 

je združljiv z večino tiskarskih sistemov. Izberemo PDF/X standard (npr. PDF/X-1a ali 

PDF/X-4), ki je posebej zasnovan za tisk in vključuje vse potrebne informacije, kot so bleeds 

in obrezne oznake. 

 

Slika 34: Shranjevanje datoteke kot PDF/x-1a 

(38) 
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5.4.2 Izbor materialov 

Izbor materialov za tisk je ključnega pomena, saj vpliva na končni videz in občutek koledarja. 

Ta faza vključuje: (11) 

Vrsta papirja: Izbira prave vrste papirja vpliva na kakovost tiskanja, trajnost in občutek 

izdelka.  

Izbrala sem premazni papir za naslovnico in mesečne strani koledarja. To pomeni, da ima 

površina papirja zaščiteno plast, ki izboljša kakovost tiska in zagotavlja sijajen zaključek. Ta 

vrsta papirja omogoča živahne barve in ostre slike, kar je pomembno za ustvarjanje 

privlačnega in profesionalnega videza koledarja. 

Teža papirja: Teža papirja, izražena v gramih na kvadratni meter (g/m²), vpliva na trdnost 

in občutek papirja. Debelejši papirji zagotavljajo večjo kakovost in trajnost, medtem ko lažji 

papirji lahko znižajo stroške tiskanja in prevoza.  

Notranje strani koledarja so tiskane na papirju s težo 100 g/m². Ta papir je dovolj tanek, da 

omogoča enostavno obračanje strani, vendar še vedno dovolj trden, da zagotavlja kakovost 

tiska in vzdržljivost za vsakodnevno uporabo. Uporaba tega papirja pripomore k lahkosti in 

cenovni dostopnosti koledarja. 

Za zadnjo stran koledarja sem izbrala težji papir s težo 200 g/m². Ta papir zagotavlja dodatno 

trdnost in zaščito, kar prispeva k dolgotrajni vzdržljivosti koledarja. Zadnja stran je 

pomembna za zaščito notranjih strani in za dodajanje končnega, profesionalnega videza 

koledarju. 

Način vezave: Izbor vezave (npr. spiralna, šivana, lepljena) je odvisen od želenega videza in 

funkcionalnosti koledarja.  

Koledar je vezan s spiralno vezavo, kar omogoča enostavno obračanje strani in omogoča, da 

koledar ostane odprt na določeni strani. Spiralna vezava dodaja tudi sodoben in funkcionalen 

videz ter povečuje uporabnost koledarja, saj uporabnikom omogoča, da ga uporabljajo brez 

težav. 

5.4.3 Testni tisk 

Izvedba testnega tiska je pomembna za preverjanje kakovosti in natančnosti končnega 

izdelka. Po prejetju testnega tiska je treba analizirati rezultate in primerjati z digitalnimi 

predlogami. Pomanjkljivosti, kot so napačne barve, težave z ločljivostjo ali napake pri 

vezavi, je treba identificirati in popraviti. Pri testnem tisku nismo opazili nobenih težav, zato 

je šel koledar v tisk. 
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5.4.4 Končni izdelek 

Po uspešno opravljenih testih in prilagoditvah se pristopi k izdelavi končnega produkta. Ta 

faza vključuje: 

Naročilo tiskanja: Po potrditvi končne različice se datoteke za tisk pošljejo tiskarni skupaj 

z navodili za tiskanje. Pomembno je, da se zagotovi, da so vse specifikacije, kot so količina, 

vrsta papirja in način vezave, natančno določene. 

Kakovostna kontrola: Po prejemu končnih koledarjev je pomembno izvesti končno 

preverjanje kakovosti, da se zagotovi, da izdelek ustreza vsem standardom in specifikacijam. 

Pakiranje in distribucija: Koledarji se nato pakirajo in pripravljajo za distribucijo. 

Pomembno je, da se ustrezno zaščitijo med transportom, da se prepreči kakršnakoli škoda. 

 

 

Slika 35: Končni izdelek 

(36)  
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6 Rezultati in razprava 

V diplomskem delu smo se osredotočili na oblikovanje stenskega koledarja za leto 2024, kar 

je vključilo raziskovanje vpliva zgodovinskih koledarjev na sodobne koledarje, analizo 

aktualnih trendov v grafičnem oblikovanju, načrtovanje vsebine in strukture koledarja ter 

tehnično realizacijo in pripravo za tisk. Osrednji cilj je bil ustvariti koledar, ki ne le estetsko 

zadostuje sodobnim trendom, ampak tudi izpolnjuje funkcionalne zahteve uporabnikov. 

• Raziskovanje vpliva zgodovinskih koledarjev na sodobne koledarje 

Raziskovanje zgodovinskih koledarjev je razkrilo, kako so se koledarski sistemi razvijali 

skozi čas, kar je imelo pomemben vpliv na sodobno oblikovanje koledarjev. Ugotovili smo, 

da zgodovinski koledarji pogosto uporabljajo bogato dekoracijo in simboliko, medtem ko 

sodobni koledarji teže k minimalizmu in funkcionalnosti. Vključevanje zgodovinskih 

elementov, kot so tipične barvne sheme ali oblikovne značilnosti, lahko obogati sodoben 

koledar, vendar je pomembno, da se to stori na način, ki je usklajen z današnjimi estetskimi 

in funkcionalnimi standardi. 

• Sodobni trendi v grafičnem oblikovanju koledarjev 

Analiza sodobnih trendov je pokazala, da so ključni trendi za leto 2024: personalizacija, 

interaktivnost, minimalizem, tematski dizajn in drzni barvni kontrasti. Personalizacija 

koledarjev, vključno z dodajanjem osebnih fotografij in pomembnih datumov, je postala zelo 

priljubljena. Interaktivni koledarji z QR kodami in povezavami do spletnih vsebin omogočajo 

uporabnikom dostop do dodatnih informacij, kar povečuje njihovo funkcionalnost in 

privlačnost. Minimalističen dizajn še vedno ostaja pomemben zaradi svoje preprostosti in 

preglednosti. Po drugi strani pa umetniške ilustracije in tematski dizajn prispevajo k estetski 

vrednosti koledarja, medtem ko drzni barvni kontrasti dodajo dinamičnost in vizualni učinek. 

• Načrtovanje in struktura koledarja 

Pri načrtovanju koledarja smo upoštevali rezultate ankete, ki je razkrila preference 

uporabnikov. Večina anketirancev je raje izbrala stenski koledar v pokončnem A3 formatu, 

kar smo upoštevali pri končni zasnovi. Vsebina koledarja vključuje fotografije, klasično 

koledarsko postavitev ter praznike in pomembne datume, kar je skladno z željami 

uporabnikov. Barvna shema je bila temnejša in nevtralna, tipografija pa preprosta in klasična, 

kar se je izkazalo za najbolj zaželeno med anketiranci. 

• Tehnična realizacija in priprava za tisk 

Tehnična realizacija koledarja je vključila uporabo programov Adobe Photoshop in Adobe 

Illustrator. Photoshop je bil uporabljen za obdelavo fotografij in napredno manipulacijo slik, 

medtem ko je Illustrator služil za urejanje vektorskih grafik in tipografij. Končni koledar je 

bil natisnjen na kakovostnem papirju, kar je pripomoglo k visoki estetski in funkcionalni 

vrednosti izdelka. 
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• Ugotovitve in sklepi 

Koledar je bil izdelan v skladu z modernimi trendi in potrebami uporabnikov. Na podlagi 

rezultatov ankete smo prilagodili vsebino in oblikovanje koledarja, kar je privedlo do 

pozitivnega sprejema med uporabniki. 

Cilj prodaje 100 koledarjev je bil presežen, saj je bilo prodanih 180 koledarjev. Prodaja je 

presegla začetna pričakovanja, kar potrjuje uspešnost oblikovalskega pristopa in tržno 

povpraševanje po prilagojenih, estetsko privlačnih koledarjih. Ta uspeh dokazuje, da je bil 

projekt uspešno izpeljan in da je izdelek zadostil potrebam in željam ciljne publike. 

 

Slika 36: Koledarji, pripravljeni za pošiljanje 

(36) 

 

V prihodnje bi bilo smiselno raziskati možnosti dodatnih izboljšav in prilagoditev na podlagi 

nadaljnjih povratnih informacij uporabnikov ter preučiti potencial za širitev produktne linije 

ali vključitev novih funkcionalnosti v prihodnjih izdajah koledarjev. 
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7 Zaključek 

V teoretičnem delu smo se osredotočili na vpliv zgodovinskih koledarjev in njihovih 

oblikovalskih elementov na sodobne koledarje. Zgodovinski koledarji so bili ključni za 

razvoj koledarjev, ki jih poznamo danes, in njihova preučitev nam je omogočila razumevanje 

temeljnih načel in oblikovalskih odločitev. Analizirali smo različne zgodovinske oblike 

koledarjev ter njihov vpliv na sodobno oblikovanje, kar nam je pomagalo razumeti, kako so 

se oblikovalski trendi razvijali skozi čas. Pregledali smo različne vrste koledarjev, vključno 

s stenskimi, namiznimi in žepnimi koledarji. Vsaka vrsta ima svoje specifične značilnosti in 

prednosti, kar smo upoštevali pri oblikovanju našega koledarja.  

Poleg tega smo raziskali sodobne trende v grafičnem oblikovanju, kot so personalizacija, 

minimalizem, uporaba umetniških ilustracij in interaktivne funkcionalnosti. Ugotovili smo, 

da trenutni trendi poudarjajo individualizacijo in estetsko privlačnost, kar je pomembno pri 

oblikovanju koledarjev, ki morajo biti tako funkcionalni kot tudi vizualno privlačni. Na 

koncu smo raziskali temeljne principe grafičnega oblikovanja, vključno z uporabo naprednih 

grafičnih programov, kot sta Adobe Photoshop in Adobe Illustrator.  

Poleg tega smo v teoretičnem delu postavili hipoteze, ki so usmerjale naše raziskovanje in 

razvoj koledarja. Te hipoteze so vključevale: 

• H1: Zgodovinski razvoj koledarjev je vplival na oblikovanje sodobnih koledarjev, pri 

čemer sodobni koledarji še vedno vključujejo elemente tradicionalnih sistemov. 

• H2: Personalizirani koledarji povečujejo njihovo funkcionalnost in uporabniško 

zadovoljstvo v primerjavi z standardnimi koledarji. 

• H3: Koledarji, ki vključujejo vizualne in funkcionalne elemente, so bolj uspešni pri 

doseganju ravnotežja med estetsko privlačnostjo in funkcionalnostjo. 

• H4: Uporaba naprednih grafičnih programov vodi k bolj profesionalnemu videzu in 

višji kakovosti končnih koledarskih izdelkov. 

• H5: Koledarji, ki vključujejo fotografije, specifične za letne čase, povečujejo 

uporabniško zadovoljstvo. 

Opravili smo tudi anketo, ki smo jo uporabili za zbiranje podatkov o preferencah in potrebah 

uporabnikov, kar nam je omogočilo, da smo prilagodili vsebino in oblikovanje koledarja v 

skladu z dejanskimi željami in pričakovanji ciljne publike. Rezultati ankete so nam 

dali  informacije za oblikovanje koledarja, ki zadostuje potrebam in željam uporabnikov ter 

vključuje vse vidike, preučene v teoretičnem delu. 

Teoretični del naloge je postavil temelje za praktični del, kjer smo uporabili pridobljeno 

znanje za razvoj in izvedbo koledarja. 

V praktičnem delu smo uporabili znanje iz teorije in razvili koledar, ki je vključeval vse 

pridobljene informacije. Osredotočili smo se na oblikovanje stenskega koledarja v 
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pokončnem A3 formatu, kar je bil najbolj priljubljen format med anketiranci. Koledar je bil 

zasnovan z uporabo temnejših, močnih barv, kar je ustrezalo raziskavam, ki so pokazale, da 

temne in nevtralne barve zagotavljajo sofisticiran videz. Izbrali smo tudi preprosto tipografijo, 

ki je bila med uporabniki najbolj zaželena. 

Postopek izvedbe koledarja je obsegal več ključnih faz, vključno z razvojem koncepta, 

oblikovanjem, pripravo za tisk in distribucijo. Na vseh teh področjih smo upoštevali 

pridobljene teoretične in praktične ugotovitve ter se trudili zagotoviti, da končni izdelek 

ustreza visokim standardom kakovosti in estetike. 

Uspešnost projekta je bila potrjena s prodajo 180 koledarjev, kar je bistveno preseglo začetni 

cilj prodaje 100 koledarjev. Ta rezultat potrjuje, da je bil naš oblikovalski pristop uspešen in 

da je koledar ustrezal potrebam in željam ciljne publike. Povečana prodaja kaže na visoko 

stopnjo zadovoljstva uporabnikov in uspešno zadostitev tržnemu povpraševanju po estetsko 

privlačnih in prilagojenih koledarjih. 

Glede na dosežene rezultate lahko zaključimo, da je bil projekt uspešno izveden. Analiza 

uspešnosti koledarja, tako z vidika oblikovanja kot prodaje, potrjuje, da so bila izbrana 

oblikovalska načela in trendi učinkovita. Koledar je zadostil potrebam uporabnikov ter 

presegel začetna pričakovanja glede prodaje. 

Zaključimo lahko, da je projekt oblikovanja koledarja pomemben prispevek k razumevanju 

sodobnih oblikovalskih trendov in potrjuje, da je kakovostno oblikovanje in dobro raziskana 

vsebina ključnega pomena za uspeh na trgu. 
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Pozdravljeni člani skupine, 

radi bi izvedeli več o vaših pričakovanjih in željah glede prihajajočega koledarja, da bo ta 

čim bolj ustrezal vašim potrebam in željam. Prosimo, da odgovorite na spodnja vprašanja. 

1. Kakšen format koledarja vam najbolj ustreza? 

a) Stenski koledar 

b) Namizni koledar 

c) Žepni koledar 

2. Kakšen format koledarja bi raje imeli? 

a) A3 pokončen 

b) A3 ležeč 

3. Katere elemente bi želeli videti na koledarju? 

(Možnih je več odgovorov) 

a) Klasična koledarska postavitev (dnevi, meseci) 

b) Prazniki in pomembni datumi 

c) Citati ali motivacijska sporočila 

d) Fotografije  

e) Ilustracije in grafike 

4. Katere barvne sheme se vam zdijo najprimernejše za koledar? 

a) Svetle in živahne barve 

b) Mehki, pastelni odtenki 

c) Temne in nevtralne barve 

d) Ni mi pomembno 

5. Kakšno tipografijo (pisavo) bi raje videli na koledarju? 

a) Klasične in preproste pisave 

b) Moderne in minimalistične pisave 

c) Kreativne in unikatne pisave 

d) Mešanica različnih stilov 

e) Ni mi pomembno 

8. Kako pomembno vam je, da koledar vsebuje dodatne funkcionalnosti, kot so: 

prostor za zapiske, nalepke, ali dodatne informacije? 

a) Zelo pomembno 

b) Pomembno 

c) Ni pomembno 

d) Ne želim dodatnih funkcionalnosti 

 

Hvala, da ste si vzeli čas za izpolnitev vprašalnika! Vaše povratne informacije nam 

bodo pomagale pri oblikovanju koledarja, ki bo čim bolj ustrezal vašim željam.
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